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Course Overview

In this volume you will learn how to set up the project framework for Design file referencing. You
will also get a quick start look a navigating the OpenRoads interface. This guide will not document
each tool that is available on the OpenRoads interface. See the online help for commands not
detailed in this document.

OpenRoads Designer CONNECT Edition Help

Skills Taught

e Design File Referencing Framework
e General Tools and Interface


https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v9/en/GUID-1B18BC16-7361-4DA1-BC57-D8A9EEF3F9E7.html
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Exercise 1 - Getting Started

1.1 Placement Tools

1.1 The Highway Tab

The Highway tab on the CTDOT workflow will be used to place 2D Linear Elements,
Shapes and Cells.

The Highway Linear, Area, and Cells tools do not automatically attach Iltem Types. Item

Types will be attached after placement by using the Properties toolbox or the Attach Item
Tool.

xl =11 b L CA\Users\richardehState of Connecticut\DOT CTDOT_ DDE - CE0D-EHRD\test station flip.dgn [2D -
Home View Al ate Attach Analyze Curves Constraints Utilities Drawing Aids Content CTDOT Alt Detailing Highway ATMS lllumination Landscaping

= [ -8 R ey T 7w e < Area ™

@ [None ~ | [Default ((none)) G E-= A X En } 5
B & o bed . 0o~ & R R End Treatments 5 Linear = =

: E =0 - = | Explorer 1 _ PoPSet  Element Fence 2 x Create — /3 Linear ~ - Cells
Bo =0 =0 @0 " 490 POl o o Selomtion Tooksw B v G 0t B v kEF v X | Region © 1 <] ¥ P Removals ™ v
Attributes Primary Selection Manipulate Modify Groups -] Roadside Safety Miscellaneous ltems

Figure 1 — CTDOT Highway Ribbon
Element Templates have been created for common pay items and can be selected under
the General >Template property by browsing to Highway \ PAY ITEMS \ ...and
selecting as needed.

Properties

4 % Elements (1)
/ Line

Line

¢ Line
FENCE_Fencing (Fend FENCE_Fencing (Fence: Fencing)

<

PAY ITEM - Fence - v

From_30_Model No
A (None) <

A1 41 enain ing fxj

(None)

0913027 REMOVE AND RELOCATE CHAIN LINK FENCE
0913031 7' CHAIN LINK FENCE
0912032 7' CHAIN LINK FENCE WITH BARBED WIRE
0913041 8' CHAIN LINK FENCE
0913043 & POLYVINYL CHLORIDE CHAIN LINK FENCE
0913044 6' POLYVINYL CHLORIDE CHAIN LINK DOUBLE
0912045 &' CHAIN LINK FENCE WITH BARBED WIRE
0913046 10° CHAIN LINK FENCE WITH BARBED WIRE
0913048 8' CHAIN LINK FENCE WITH BARBED WIRE (UN
0913050 12' CHAIN LINK FENCE .
‘ 3

PAY ITEM - Fence -

From_3D_Model No

SEARCH 0913041 8 CHAIN LINK FENCE
iption 8' CHAIN LINK FENCE

0913041

Figure 2 — Update using Element Pay Item Template
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1.1.2  Attach and Detach tools

Item Types can also be directly attached to a graphical element using the Attach Item Tool.
Item Type Tools can be found on the Attach Tab in the Item Types Group.

e Attach Item - Allows you to attach an item to an element.

o Detach Iltem - Allows you to detach an item from an element.

Attach Analyze Curves Constraints Utilities Drawing Aids Content CTDOT Alt Detailing Highway

= 70 & % I =
B ooik @ &2 OINE @

Attach  Bring B or oy Attach Detach Attach Detach -, — | Attach |Detach Picklist Import/Export
™ Raster toFront @ =¥ AL “# ~  Point Cloud Point Cloud Mesh  Mesh ‘= ltem | Item
I Raster I Peoint Cloud Ta Reality Mesh I [tern Types Ta

Figure 3 — Attach Item Type

| &1 Attach Item - O ®

| Text Style: | &3 Style (none) v | A | & Active Level {FENCE_Fencing (Fence: Fencing)} = A, |

I }ff:},' Edit Common Properties
|
| Select All 1 Selected  Clear PAY ITEM - Fence |
b &1 Drainage =11 [*) -
9 A
[ S Earthwork
| o From3D_Model (None) v o
g % [llumination
SEARCH (None) v oo
4 W 5 Incidental Construction .
ltem Description ol
| Q PAY [TEM - Block Slope Protection temNumb o
temMumber Al
D PAY [TEM - Concrete Driveway Ramp Unit oA
ni 4l
| .
| [:] PAY ITEM - Crushed Stone for Slope Protection Quantity 0.000C o
() PAY ITEM - Curbing Notes oA

! CJ PAY [TEM - Detectable Warning Surface
' () PAY [TEM - Driveway

[:] PAY ITEM - Earth Retaining System

Q PAY ITEM - Erosion Control Matting

(53 PAY [TEM - Fence

-

Figure 4 — Attach Item dialog box
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1.1.3  Feature Definitions

Graphics can be placed with OpenRoads Geometry tools, the required Item Types will be

automatically assigned when using these tools.

o Liners Feature Definitions have been created under Linear \ Roadway 2D Pay

Items \ Pay Items \ ...

 Point Features for Guiderail Ends Point\ Pay Item — Guide rail \ ...
e Drainage and Utility Nodes and Conduits also come the Pay Item Item Types

Attached

£] OpenRoadsModeling w v (@ O HEE [« -+ 2 25 = CA\Use)
G Home  Temsin cometry  Site  Comiders  Model Detailing ~ Drawing Production  Drawing  Utilities
G mport/Export ¥y P 2 3 Offsets and Tapers ~ -
I Y P W ¥ O = et L
< T (% o —_—
(8 - |#% Design Elements ~ . . A Rewerse Curves ~ .
Element Civil  Reports  Lines Arcs Point Medify _Complex
@ Selection * i Standards ~ Toggles ~ v v - * 2 Spirals ~ + " Geometry
Primary  Selection General Tools Horizontal
Iy IR o (
[3 A 0 L - E Ea Q'P |
Explorer ~ B 1 x| Properties | 4 Compl.. — * ~RIx i
TR m view1, o
File v Parameters ~ p
] 4 () ltem Types (1) | : | =&
@ Items v (3 PAY ITEM - Earthwork (Volume) @ Radius 0.000
&) Resources v Back Transition ~
| OpenRoadsMo.. % Type Mone “
& sheet Index v Ahead Transition -~
B Links v Type MNone v
| OpenRoads. -~ Feature -
Q@ P: Ttem Type Feature Definition Certerine -
b “ Standards Name

ame for Element

B Roadway 20 Pay

& Gate

-@ Stockade

LT 1T

i Pay tems - Bamier Curb
8 Pay tems - Cutbing
-8 Pay tems - Drainage
¥ Pay iems - Driveways
1 Pay ems - Eathwork
¥ Pay ems - Fences
@ Board Fence

@ Chain Link Fence
@ Fence Removal

@ Omamental Fence
@ Picket Fence

@ Protective Fence
@ Split Rail Fence

-@ Stone Wal Fence
-@ Wire Fence

Pay ems - Guidersi

Pay fems - Sidewalk Ramps

Pay tems - Sidewalks

Pay fems - Siops Protection

Pay fems - Surface Courses or Pavemerts

Pay tems - Temporary Construction

ttems

Fence

Figure 5 — OpenRoads Linear Features
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Figure 6 — OpenRoads Point Features
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An Item Type is a user defined set of properties used to describe graphical and non-graphical
information of an object or element. ltem Types are set up and managed by the CTDOT CAD
administrators as part of the delivered workspace. Item Types will be attached after
placement for elements such as lines and shapes. The workspace has been set up for

certain Cells to have Item Types attached upon placement. The properties of an Iltem Type can
be edited by the user in the Properties dialog box along with the other properties of an
element. The properties in Iltem Types can be used to label and report.

CTDOT Item Types are connected to the Department’s Master Bid List that contains pay item
numbers, descriptions and units. Users will enter the required pay item description and the
item number and pay unit fields will auto-populate. The most up to date Master Bid Item Lists
can be found on the Department’s Contract Development Website.

In the image below notice the look up information is grayed out and the user input is not. The
greyed-out properties are getting auto-populated by other Item Type property fields or other
attributes on the file itself. Some user input fields are pick lists and others are strictly manual

input.
Properties XD & viewn, Defaut
+ Ml M &~ briPLOO0 =
4/ Line
[ ltems
General v
Geometry -
Extended v
PAY ITEM - Fence ~
From_30_Model No
SEARCH 0913011 5'CHAIN LINK FENCE
tem_Description 5'CHAIN LINK FENCE
| 0913011
Init 1.
Quantity 100.0000
Motes
Raw Data hd

Figure 7 — Fence Pay Item


https://portal.ct.gov/DOT/Contract-Development-and-Estimating/Contract-Development
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121  Pay Item Properties

e SEARCH - uses a pull-down menu, by selecting the down arrow in the Property Definition,
and entering part of an Item Description or ltem Number, a selection pick list will appear.
Note: you can enter any word in the description or Number, and it will filter
regardless of the order.
¢ Item_Description - uses a look up table and will update based on the selected SEARCH
Property.
¢ Item_Number - uses a look up table and will update based on the selected SEARCH
Property
¢ Unit - uses alook up table and will update based on the selected Item _Description.
e Quantity - uses graphs and or a mix of equations to comupte the results based in the
Unit.
¢ Notes - Type in as needed.
e Optional Properties used are on some Item Types are:
o Thickness
¢ Factor
e From_3D_Model

1.2.2 Asset Information

The following CTDOT assets will be tracked moving forward so all Property fields in the Item
Types below should be fully populated and filled out for each item placed in a project.
Roadside Safety
e BARRIER CURB
e END TREATMENT
e GUIDERAIL

123 Item Types Manager

Available ltem Types can be viewed by selecting the small box on the bottom right corner
of the Item Types section.
Attach Anal ‘ CTDOT Alt Detailing Facilities Highway Nlurninaticn

A% !} °p % [E s

Attach BM-: — Attach Detach Picklist Import/Export
" Raster to - [tem  Item

F F{? F ltem Types
Item Types
o G2, Managg custom itern types and their
’ w O properties

Figure 8 - Item Types Manager
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1.3 Excel Export

The Import [ Export tool allows you to export Item Type data to Excel.

&l cmoaor r@-odBRE e A EE2F -

Home View Annotate Attach

ChUsersirichardeh'\State of Connecticut\DOT
Analyze Curves C;;;-nstraints Utilities

. ja.“ — A0 B ‘ s e
B % MHE Boliis @ &2E%:; % %G = I
Attach Detach Clip

Drawing Aids Content CTDOT Alt Detailing Highway

Attach  Bring . _— Attach Detach & Attach Detach Attach Detach Picklist] Import/Export
Reference Reference Reference [ Wi Raster to Front ii¢ Ak @ 7 Point Cloud Point Cloud Mesh  Mesh W FH ftem Item
Reference IF] Raster -] Peint Cloud -] Reality Mesh IF] Item Types IF]
Figure 9 — item Type Import / Export tool
&% Item Type Import/Export x

L Items () Libraries

Import @ Export

Active Model -

Sort Properties ©  Match ltem Type i

Selection Type & | All

Export To :

Cancel

Figure 10 — Item Type Import / Export dialog box
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Exercise 2 - Quantifying Guiderail

These instructions will guide users through placing guiderail features and provide layout steps.
Pay ltems as well as Asset information will be tagged to each feature through Item Types. During
placement each piece of linear guiderail, end anchors, bridge attachments and impact
attenuators will come with the preset (most common) bid item number. These bid items can
always be modified after placement for those out of the ordinary circumstances.

1. Create a new file and save it to your Base Model folder, HW_CB_1234_1234_ Quantities.dgn.

2. All the Items placed in a file can be viewed in the Explorer dialog box under Items. This should
be reviewed to make sure all the Items are placed correctly.

3. If you do not see the Explorer dialog box, click on the Home tab and select the Explorer button.
=] coor rodEEfe-A2 82 s
Home View Annotate Attach Analyze Curves Constraints
& Blank | Default -
Boe ~|z0 ~|(|=o0 " @0 ~|&q700 -

Attributes

Figure 11 - Explorer Icon

4. If you do not see the Items section, click on the File tab. Select Settings > Explorer Settings.
Toggle Yes, to all the fields in the Items section and click OK.

4 Explorer Settings *
File A
Visible L] v

» Displey

r Items ~
Visible Yes
Group by Label Yes

Graup by Relationship Type Yes
\ Group by Related Hem Type Yes

Resources L]
Visible No
. . OpenRoads Model A~
Settings User Settings
Visible fes
!
_ IL; & AccuDraw Settings S &
-y W —
.(_,} System (PC) Visible Tes
- Links ~
L} File t‘, Button Assignments ot =
. Indescing Service Stopped
(_I? Configuration
| Customize Ribbon OpenRoads Standards o
i
Visible Yes
p— Drainage and Utilities Model -~
Q Explorer Settings
Visible Yes

‘ Sriruea a v
FZa) Function Key:
grerer ==

Figure 12- Explorer Settings
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5.

10.

In a real-life project scenario, the edge of road will already be placed in the design before the
guiderail layout begins. For the purposes of this exercise, we will place a line to represent the

edge of road. Select the OpenRoads Workflow, on the Geometry Tab, in the Horizontal section

select the Lines icon. The Lines dialog box will appear, for Feature

Definition select Linear|Roadway Geometry | Edge of Pavement Line. Follow the prompts and

place a 100-foot line.

Switch the workflow to CTDOT, on the Home tab, in the Manipulate area select Copy.

In the Attributes section, change the Element Template to None and the Level to Default.

Now move the line Parallel. Select the Move Parallel tool.

e Turn on distance and enter 2.
e Turn on Use Active Attributes

e Make Copy not set

(!

[

0~ 0,

Meode: | Miter ~
Eistance: 2000 f—

e
Use Active Attributes

Make Copy

Figure 13 - Copy Parallel Dialog Box

Change use the Place Smart Line tool to place the flared Guiderail sections and trim the

parallel line to the flared sections.

In the Search ribbon type Create Complex Chain and select the tool. Follow the prompts and

select each section of Guiderail to create a complex chain. Break the line where needed to add

sections for different post spaced pay items.

10
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1. Switch the Workflow to OpenRoads Modeling, in the Geometry > Horizontal > Offsets and
Tappers > Single Offset Entire Element.

&4 OpenRoads Modeling v W8 HEce«-2 482 -
m Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Lt

] - - - o ™ -5
8 o < Import/Export I L ,  — Offsetsand Tapers ¥ ‘ru;
s O @

#; Design Elements ~ % Single Offset Entire Elernent

= - J

1ZF Single Offset Partial

B - Element ., ) Chvil Reports Lines  Arcs  Point
ey Selection i} ™ | ¥ Standards ~ Toggles - - - -

Primary Selection General Tools X Variable Offset Taper
C-4- n

=& Ratio Offset Taper

Figure 14 - Single Offset Entire Element

12. In the dialog box
Offset = ON & setto 0
Remove Offset Rule ON

Feature = Linear > Roadway 2D Pay Items > Pay Items — Guiderail > MBR

25 single Offset Enti.. — P
Parameters ~

Offset: 0.000

Use Spiral Transitions [

Mirror I
et -l o Feature Definition
Jir---l_,.i Alignment
E -8 Linear

i---L,.j Roadway 2D Pay ltems

j -l Pay ttems - Bamier Curb

-l Pay ltems - Curbing

-l Pay ttems - Drainage

-l Pay ltems - Driveways

-l Pay ltems - Earthwork

-l Pay ltems - Fences

-l Pay tems - Guiderail

= Guiderail - Removal

MER &%

MER - klf Post Spacing

MER - Quarter Post Spacing

MER - Span Type Il

MER - Span Type Il

MBR Median

Memitt Pardcway Guiderail

Memitt Padoway Guiderail - System 2

Memitt Padcway Guiderail - System 3

Memitt Pardcway Guiderail Median

Three Cable

Three Cable - System 2

Three Cable - System 3

Remove Offset Rule

Feature

Feature Definition

Name

[ e s O OO e IO

ARRVRARVAVRVRAAVRVRAAR D

Figure 15 - Linear Guiderail Feature Selection

13. Select the first line and follow the prompts place the Feature. Move on to the next segment if
one exists and change the Feature Definition as required if the post spacing changes.

14. Add the Point Features End treatments. On the Geometry tab’s Horizontal section select Point.
1
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Feature Definition: select as needed there are different folders to help searching through

the types.

Points > Roadside Safety > Attachments...
Points > Roadside Safety > Attenuation Systems...
Points > Roadside Safety > End Anchorage...

Follow the prompts to place the Cells.

EJ OpenRoads Modeling ~ @8- H l[:} fa « - T2 = C:\Usershrichardeh’\5tate of

m Home Terrain Geometry Site Comidors Model Detailing vg Production Drawing
= e r r = . r
i <. Import/Export ~ b - P w -t Offsets and Tapers ~
Ny k A, i O b \fj

#; Design Elements = H =i Reverse Curves =

Element ... Ciil Reports Lines Arcs  Point Medify
] Selection L. ™ @ Standards * Toggles = v = - v | 2= Spinals ~ )
Primary Selection General Tools Horzontal
Figure 16 - Place Point Feature Tool
Jr?' Point -
Elevation
Elevation Mode None
Rotation
Rotation Mode Q?
([ Rotation -5 Point
: =~ Pay tems - Guiderail
FlimT ---L,,.j Attachments
- Attenuation Systems
Feature Definition =1~ End Anchorage
Name @ BX6 Box Beam Anchorage
- @ MD-B Anchorage Type |
Description @ MD-B Anchorage Type Il
@ Menmitt Anchorage Type |
@ Memitt Anchorage Type |l
@ Memitt Anchorage Type 11
@ Memitt Median Anchorage
@ R-B Anchorage Buried Type
@ R-B Anchorage Ledge Type
- @ R-B Anchorage Type |
@ R-B Anchorage Type Il
@ R-B Teminal Section - it
@ R-B Terminal Section -t
- @ Three Cable Anchorage Bured Type
- @ Three Cable Anchorage Type |
@ Three Cable Anchorage Type Il
- @ Timber Anchorage

Figure 17 — Point Guiderail End Feature Selection

Litilities

~

Complex
Geometry =

g

12
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15. Select the Lines and Points just placed and fill in the RB-Run_ID. Use the SEARCH field to
look up any needed changes to the Pay Item, the Pay Item Number or Description can be
entered to search.
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== = whan £
RiE-on_ 1 GUIDERAIL ) Tended
-_-.-;’.-L J:I::::Mﬂu R 3 AUIERATL il
Saceit_Trin Tl Trrmert St HEW 3R I 1
" CEOO-EHAD Tyee F-f (MASH] W
R-B END ANCHORAGE-TYPE | Segment_Typa Gciorad il (REASH
agars_Typa Cusdborzd
FAY ITLM - Rosduide Salety FOOEHAD
{ 1 MASH A
g SIERZ DL EWE) SR HOPARC-TVRE.A METAL BEAM FRASL (B MASH HALF Y
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1.0000 METAL BEAM FAIL (H-8 MASH SEARCH 0910301 METAL BEAM RAIL [R-B MASH HALF
Moles 97000 MIETAL BEAM FLAIL [FE MASH HALF POST SF
LY 0910
Genmetry Peenks 1 o 0710574 i
Moies
Point Comatrmnts iotes
Transisen Offset fule v
Fanstes Offset Rule -
Gaomatry Paints -
seometry Peints w

Figure 18 - Add Run ID's
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Exercise 3 - Drainage

Coming Soon

14
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Exercise 4 - Volumes

Coming Soon

15
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